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Глава 1. Объекты исследования в среде Ptolemy

Программа PTOLEMY является частью наиболее популярного сегодня пакета анализа радиосистем: ADS (Advanced Design System). Современное проектирование все больше и больше нуждается в применении алгоритмов DSP (Digital Signal Processing), как для моделирования конкретных микросхем и процессоров, так и анализа специфических характеристик радиосистем (таких, например, как точность наведения на цель, ошибка поражения, частота передачи ошибочной информации), объединяющих статистические и детерминированные параметры радиотехнических систем. Программа PTOLEMY как раз и предназначена для анализа цифровых схем и алгоритмов, занимающих в современной системе связи все больший удельный вес, а также для анализа аналоговых частей с применением алгоритмов цифрового моделирования.

В основе любой программы моделирования обычно лежит некоторая форма представления данных, опираясь на которую разработчики могут использовать готовые алгоритмы или создавать новые. Например, в системе MATLAB способ представления данных следует уже из самого названия пакета (MATLAB, Matrix Laboratory), т.е. основным объектом в MATLAB является матрица, а все алгоритмы и пакеты рассматриваются как операторы над этими матрицами. В программе PTOLEMY основным инструментом анализа служит синхронизированный поток данных, передаваемый между блоками модели.

1.1. Организация процесса моделирования на основе синхронизированного потока данных

Создатели программы PTOLEMY сосредоточились на реализации возможности совместного моделирования подсистем, для которых сигнал традиционно представляется различными способами. Например, в СВЧ тракте сигнал удобно представить в виде комплексной огибающей, в то время как для цифровой фильтрации в базовой полосе частот удобнее работать с массивом данных. Поэтому в системе нет основного типа данных, но есть способы передачи данных между составными частями.

Достижение подобной гибкости потребовало немалых усилий. PTOLEMY была разработана в Калифорнийском Университете Berkeley [5] и являлась естественным развитием двух предыдущих поколений подобных сред: BLOSIM и GABRIEL. Компания HP EEsof сформировала на основе кода UC Berkeley программу HP PTOLEMY и добавила большое количество моделей, необходимых для разработки систем связи: модели каналов распространения радиоволн и антенн, нелинейные усилительные блоки, кодеры, декодеры, а также библиотеки компонент GSM, CDMA, 3GPP и др. К основным достоинствам PTOLEMY можно отнести:
· моделирование выполняется с помощью синхронизированного потока данных (понятие потока рассмотрено далее);

· допускается совместное моделирование (косимуляция) элементов с цифровым и аналоговым представлением; 
· существует возможность разработки и добавления моделей аналоговых и цифровых устройств и алгоритмов;

· программа имеет интерфейс для подключения средств измерения и контроля сигналов внешних генераторов;

· гибкая подсистема визуализации результатов с возможностью последующей обработки полученных данных.
В PTOLEMY различные специализированные проектные среды обозначаются термином домен (в известной терминологии домен – это, например область частот, область времени или область кодов). При моделировании цифровых узлов часто используется понятие синхронного потока данных (SDF, Synchronous Dataflow). Классический синхронный поток данных SDF это способ организации вычислений, при котором моменты появления новых данных на входах компонент точно определены на этапе компиляции. Вместо термина SDF в литературе иногда используются понятия управляемый данными домен (data driven) и статически планируемый (statically scheduled) домен. Термин Data-driven означает, что какая-либо из компонент схемы может быть активирована (fired) только после появления данных на ее входах. Компоненты без входов (генераторы сигналов) готовы к активации всегда. Термин «статический» указывает на тот факт, что порядок возбуждения определяется один раз вначале моделирования.

При разработке PTOLEMY специалисты Hewlett Packard  значительно улучшили алгоритмы обработки синхронного потока данных SDF (Synchronous Dataflow). Новый домен для аналогичных, но синхронизированных по времени потоков данных, носит название TSDF (Timed Synchronous Dataflow).

 Синхронизированный поток данных - одно из важнейших свойств PTOLEMY. Это означает, что расчет выполняется в области цифрового представления, а не в области непрерывных значений напряжений и токов. Для реализации этого метода необходимо было разработать ряд различных планировщиков расчета, включая параллельный, для ускорения процессов вычисления.

Приведенные выше термины будут подробнее рассмотрены в следующих главах, а сейчас рассмотрим короткий пример создания модели в среде PTOLEMY.

1.2 Первый пример: моделирование интегратора
Начнем изучение PTOLEMY с примера интегратора. В схеме DSP используем делитель, сумматор и задержку, чтобы реализовать схему с петлей обратной связи. Далее прибавим источник сигнала, устройство вывода и контроллер, а затем выполним моделирование и выведем результаты расчета. Нажмем кнопку Examples Directory, и затем кнопку Browse в главном окне ADS (рис.1.1). 
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Рис. 1.1. Главное окно ADS, из которого запускается Ptolemy

Выберем пример в директории examples\Tutorial\integrator_prj из списка файлов (рис. 1.1). Откроем проект и дважды щелкнем на файл integrator1.dsn, чтобы открыть его. В рабочей части интерфейса PTOLEMY, которая является и интерфейсом ADS, появляется схема интегратора (рис. 1.2).
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Рис. 1.2. Схема интегратора в виде соединения элементов Ptolemy

Прибавим источник синусоидального напряжения на вход, а также окно вывода данных и контроллер DF (понятие контроллера рассмотрено далее) к схеме интегратора (рис. 1.2). Имеются два способа выбрать библиотечные компоненты:

1. Из палитры «Palette List». Окно слева содержит список палитры и значки для каждого элемента в палитре. Выбираем элементы на палитре и затем щелкаем на значках в палитре.

2. Также можно выбирать компоненты из библиотеки, командой меню Component->Component Library. Появляется диалоговое окно, в котором можно выбрать компоненты в библиотеке.

 Сначала будем использовать палитру Palette List. Компонента, которую мы ищем, находится в библиотеке «Common Components». Нажмем значок генератора SineGen. При перемещении указателя поверх окна проекта, появляются  перекрестие и символьное изображение генератора.
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Рис. 1.3. Установка параметров синусоидального генератора. Выборки значений синусоидального генератора выполняются через RadianPerSample

Поместим генератор на схему слева от компоненты Fork2, затем нажмем левую кнопку мыши. Компонента генератора помещена в окно проекта. Ниже его изображения на схеме виден список параметров: название компоненты и редактируемые параметры (рис.1.3). Примем эти значения по умолчанию. После того, как компонента размещена на схеме, нажмем клавишу «Escape». Перекрестия исчезают, а компонента остается на месте.

Продолжим составление схемы и добавим окно вывода результатов. Но на сей раз, мы будем использовать выбор из библиотеки Component Library.

Выберем команду Component->Component Library. Появляется диалог, в котором показаны компоненты в каждой библиотеке. Слева в библиотечном списке, выберем шестой снизу элемент, Interactive Controls and Displays. С правой стороны, выделим TkPlot. (другой такой же элемент TkPlot уже имеется в схеме для отображения входного сигнала.) Переместим перекрестие в правую верхнюю часть схемы (справа от компоненты Fork2), затем нажмем левую кнопку мыши. Схематическое представление TkPlot (рис. 1.4) отображается на схеме, чуть ниже находятся название компоненты и редактируемые параметры. Закроем диалоговое окно Component Library нажатием OK.
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Рис. 1.4. Символ элемента интерактивного 
вывода данных TkPlot и его параметры
Изменим два параметра для этого элемента. Для этого можно использовать несколько разных способов:

· дважды щелкнув сверху компоненты;

· выбором Edit>Component>Edit Component Parameters;

· нажимая кнопку Edit Component Parameters на инструментальной панели;

· указывая значение параметра непосредственно на схеме. Для изменения какого-либо из параметров просто щелкните по нему мышью, цвет текста изменится и станет доступным для редактирования. По окончании редактирования нажмем «Enter».
Теперь используем редактирование в диалоговом окне. Дважды щелкнем на элемент TkPlot. Появляется диалоговое окно (рис. 1.5). Выберем параметр xRange (слева, рис. 1.5). На правой стороне диалога вместо 100 введем 400. Выберем параметр yRange (слева). Вместо  -1.5 1.5 введем 0 32. Точно так же выберем параметр Persistence, и изменим значение 100 на 300. Наконец, напечатаем Output в области Label (вверху списка) так чтобы вывести на график надпись «Output». Нажмем OK.
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Рис. 1.5.Установка параметров окна  вывода
Теперь выполним соединение компонентов с помощью проводов. Выберем команду Component>Wire, или нажмите кнопку Add Wire на инструментальной панели (строка в середине внизу). Подключим провод от порта синусоидального источника SineGen к входу Fork2. Когда порт соединится, цвет узла изменится с красного на синий.

Соединим верхний провод от компоненты Fork2 к компоненте TkPlot. Провода должны быть подключены к портам парами. Прежде, чем прибавлять провод, на схеме должны быть размещены, по крайней мере, две компоненты.

В заключении на схему поместим контроллер. Контроллеры определяют выбор математического аппарата для построения модели и параметры моделирования. Из палитры с названием Common Components, выберем значок Control (справа, второй сверху). Переместим перекрестия в нижнюю левую часть схемы, затем нажмем один раз левую клавишу мыши. 

Символ компоненты контроллера будет помещен в окно проекта. Контроллеры не связаны проводами с другими компонентами. Примем значения параметров контроллера по умолчанию (рис.1.6).
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Рис. 1.6. Установка параметров контроллера DF
Имеются несколько типов контроллеров; тот, который мы выбрали, называется Data Flow Controller, и именно он используется для обработки смешанных численных и аналитических установившихся сигналов. Окончательная схема интегратора будет иметь вид, показанный на рис. 1.7.
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Рис. 1.7. Окончательная схема интегратора с генератором на входе и интерактивным выводом. Такой интегратор можно рассматривать как звено во многих схемах DSP, например, цифровых фильтрах

Теперь, когда мы имеем законченную схему, можно запустить процесс моделирования. Элемент TkPlot сразу начинает показывать результаты моделирования. Позже мы заменим его элементом «Sink» в схеме, который сохранит результаты моделирования в файле. После окончания моделирования используется панель Data Display, чтобы увидеть окончательные результаты.

Выберите команду Simulate > Simulate, или нажмите на кнопку запуска расчета 
[image: image8.png]


. Начнется процесс моделирования. Появляется окно состояния, которое дает Вам информацию о процессе моделирования или сообщает об ошибках. Одновременно с этим появляются два окна TkPlot. В них отображается движущаяся синусоидальная волна на входе и результаты моделирования на выходе интегратора (рис.1.8).
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Рис. 1.8. Сигнал на входе интегратора напоминает синусоиду, но следует учесть, что алгоритм DSP работает только с выборками этого процесса
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Рис. 1.9. Результаты моделирования на выходе интегратора. Сигнал на входе и сигнал на выходе cдвинуты на 90(
Источник SineGen генерирует последовательность чисел согласно формуле sin([image: image11.png]
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), n=0, 1, ..., где[image: image14.png]


RadiansPerSample и[image: image15.png]


InitialRadians. Выбранные параметры генератора показывают, что выборка выполняется через 3.6(.

 Просчитывая каждую выборку, используя параметры расчета, заданные контроллером DF, интегратор преобразует синусоидальное напряжение источника в косинусоидальное, что показано на рис. 1.9 (т.е. выполняется смещение по фазе на 90().

Моделирование может быть остановлено вручную. Для этого нажмем кнопку Quit из диалогового окна, который появляется во время процесса расчета. Этот интерактивный вывод не сохраняет результатов расчета. Чтобы сохранить результаты расчета, нужно использовать другой подход, применяя элемент Sink (рис. 1.10).

Выберем выходной элемент TkPlot на схеме. Нажмем клавишу Delete, или выберем значок блокирования (перекрестие) на инструментальной панели. Из списка палитры Common Components, используем значок NumericSink (около нижней части, левый). Поместим NumericSink (рис.1.10) там, где был первоначально элемент TkPlot. 
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Рис. 1.10. Накопитель численных данных NumericSink

Дважды щелкнем NumericSink, чтобы отредактировать его параметры. Установим Start = 0, Stop = 200. Нажмем OK.

Выберем Simulate>Setup. Появляется диалоговое окно Simulation Setup. Этот шаг используется, когда необходимо явно назвать набор данных. В области набора данных, напечатаем myresults. Это имя становится именем файла результатов моделирования. Выберем кнопку Simulate (в нижней части). Начинается моделирование, появляется окно состояния, которое дает информацию относительно моделирования или сообщает об ошибках.

На сей раз, данные сохраняются на диске. Эти данные могут быть прочитаны, переведены в другой формат или использованы для последующей обработки.

Выберем Window>New Data Display. Будет открыто окно Data Display. Из раскрывающегося списка рядом с Plot Types, выберем myresults. Этот список состоит из заданного по умолчанию списка набора данных.

Нажмем значок Rectangular Plot в списке палитры Plot Types, слева от окна. Появится прямоугольная рамка. Выберем OK. Данные будут выведены в окне Data Display, как показано на рис. 1.11.
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Рис. 1.11. Накопленные данные, выведенные в окно Data Display

Итак, мы использовали два метода для отображения потока данных: 

1. TkPlot (один из нескольких интерактивных элементов), который не записывает данные на диск;

2. Окно Data Display, которое  накапливает данные и показывает их в ряде форматов.

1.3. Второй пример: Моделирование приемника сотовой связи на базе стандарта CDMA2000

Известно, что метод уплотнения каналов в системе связи CDMA (Code division multiple access) имеет существенные преимущества перед системами TDMA(Time division multiple access) и FDMA(Frequency division multiple access). Все три технологии подразумевают разделение выбранного домена (частот, времени или кода) между пользователями. Например, в технологии TDMA используется разделение информации на временные интервалы (слоты). При создании нового соединения ему назначается номер слота для передачи и приема (или несколько слотов). Таким образом, каждый пользователь передает и принимает сигнал на одной несущей в строго определенные моменты времени. Этот метод используется в сетях сотовой связи GSM. 

При использовании CDMA цифровой сигнал от одного пользователя умножается на цифровую последовательность, закодированную кодом Уолша, разной для каждого пользователя. После этого сигнал в базовой полосе приближается по свойствам к случайному шуму, и его спектр значительно расширяется. Этот сигнал передается в эфир с амплитудой уменьшенной в соответствии с расширением исходного спектра. Таким образом, исходный спектр сигнала как бы «размазывается» и выглядит как спектр шума с малой амплитудой.

Приемник такого сигнала использует тот же код Уолша для выделения сигнала данного пользователя и восстанавливает исходный сигнал из принятого шума. (Это упрощенное пояснение работы системы CDMA, которая, в действительности использует несколько шагов расширения спектра).

Системы связи на базе CDMA имеют ряд преимуществ по сравнению с TDMA, например, они эффективнее используют выделяемый под передачу спектр, имеют защиту от несанкционированного доступа на уровне кодирования сигнала. К недостаткам таких систем следует отнести в первую очередь сложность реализации.

Рассмотрим модель приемника CDMA. Откроем каталог examples и выберем подкаталог CDMA2K. Выберем проект CDMA2K_Rake_prj. В подкаталоге networks выделим DSNCDMA2K_FwdRake.dsn. В окне справа активируем DSNCDMA2K_FwdRake (Schematic). Загружается схема, показанная на рис. 1.12.
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Рис. 1.12. Схема приемника CDMA2000

Рассмотрим, из каких компонентов состоит данная схема приемника CDMA2000 Forward Link Rake Receiver. В левом верхнем углу находится источник информационного сигнала Data. Он реализован в виде генератора случайного битового потока. Этот битовый поток NRZ (Non return to zero – не возвращаемый к нулю) поступает на модуль кодирования. Полученная последовательность подается на блок Distributor2, который разделяет последовательность на два потока, которые будут передаваться параллельно как синфазная и квадратурная компоненты для фазового модулятора QPSK(Quadrature phase shift keying, квадратурная фазовая манипуляция). 

Под квадратурной модуляцией будем понимать одновременную передачу двух каналов в одной полосе частот за счет использования двух ортогональных сигналов одной несущей частоты. Термин модуляция (modulation) будем использовать в тех случаях, когда модулирующий сигнал – аналоговый, если модулирующий сигнал цифровой, то будем говорить о манипуляции (keying).
Каждый из полученных потоков умножается на свою последовательность (функцию Уолша) для расширения спектра. На основе полученных последовательностей формируется комплексный сигнал, который подается на вход модулятора QPSK. На выходе модулятора сигнал фильтруется и к нему подмешивается белый шум канала AWGN (additive white gaussian noise). 

На приемной стороне (нижняя часть схемы) реализован оптимальный приемник, использующий те же функции Уолша для восстановления сигнала. Пройдя через все этапы (корреляционный прием, демодуляция, декодирование), восстановленный сигнал поступает на вход компоненты BER (рассчитывающей параметр Bit Error Rate - частоту ошибочных битов). Модуль BER сравнивает принятый сигнал с задержанным неискаженным сигналом с целью расчета битовых ошибок в реальном тракте относительно идеального тракта BER. Выходом блока BER является текущая величина BER и текущее кол-во измерений (термин «измерение» в литературе, посвященной описанию программ, часто эквивалентен термину «численное моделирование»). Результаты работы блока BER сохраняются в элементе Sink для последующего анализа.

Запустим процесс моделирования командой Simulate->Simulate или нажимая клавишу F7.  Появляется окно рис. 1.13, отображающее процесс вычислений:
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Рис. 1.13. Окно отображения/контроля моделирования.

В окне статуса последовательно появляются строки о количестве обработанных циклов передачи в процентах:

DF1: Data collection is  0.1% complete.

После достижения 100%, (это занимает для данного примера несколько часов расчета) процесс моделирования следует остановить с помощью кнопки Quit. Вся полученная информация сохраняется в компонентах Sink. Для отображения результатов выберем Window->New Data Display. В появившемся окне выберем Insert->Equation.

В окне вывода данных напечатаем выражение:  SpreadGain = 64. Повторим это для выражений: 
  Ratio_Eb_N0 = SpreadGain*4*2/CDMA2K_FwdRakeAWGN..NoiseVariance

  Ratio_Eb_N0dB= 10*log(Ratio_Eb_N0)

Нажмем клавишу Rectangular Plot и выберем место для графика. В колонку Traces добавим BER, а потом отредактируем его: vs(CDMA2K_FwdRakeAWGN..BER, Ratio_Eb_N0dB). Вы должны увидеть график, показанный на рис. 1.14. 
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Рис. 1.14. Результаты моделирования приемника CDMA2000

В отличие от первого рассмотренного примера интегратора рис. 1.7, где каждый элемент выбран как элемент из библиотеки, схема приемника на рис. 1.12 значительно более сложная. Большинство элементов на ней – это иерархические схемы, каждая из которых в свою очередь состоит из большой разветвленной схемы. Например, выделенный на схеме рис. 1.12. цифовой фильтр CDMA2K_BaseFilter, при выделение его и нажатии на кнопку 
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 в верхней панели (или командой снижения уровня иерархии  Push Into Hierarchy в меню View, мы видим схему, показанную на рис. 1.15.
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Рис. 1.15. Блок-схема цифрового фильтра

Эта схема цифрового фильтра, в свою очередь состоит из преобразователя CxToRect комплексного числа в алгебраическую форму (Re и Im части), двух цифровых фильтров в каждой ветви, и блока объединения снова в комплексную форму RectToCx. Активизировав и нажав два раза на библиотечный элемент CDMA2K_FIR на схеме рис. 1.15 мы вызываем окно (рис. 1.16), в котором можно изменить параметры этого цифрового фильтра.
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Рис.1.16. Установка параметров цифрового фильтра: тип ввода и скорость передачи данных (PN chip rate)
Таким образом, элемент CDMA2K_BaseFlter построен с двумя уровнями иерархии. В этом же приемнике (рис. 1.12) находится элемент опорного генератора CDMA_CarrierFreqEstimate, выделив который и снизив иерархию, увидим схему рис. 1.17.
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Рис. 1.17. Схема опорного генератора приемника CDMA2000 Forward Link Rake Receiver
В эту схему, кроме библиотечных элементов DSP, входит схема фазового детектора CDMA2K_PhaseDetector, активизировав которую и нажав кнопку 
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 мы увидим схему рис. 1.18, из которой она состоит.
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Рис. 1.18. Схема фазового детектора

Схема фазового детектора состоит из библиотечных элементов DSP и по своим функциям близка к интегратору, рассмотренному в примере 1. 

Таким образом, уровень иерархии для опорного генератора равен трем. Иерархическое построение схем значительно упрощает проектирование сложных систем с помощью программы PTOLEMY. В следующих главах мы последовательно, привлекая примеры, будем выполнять моделирование отдельных узлов радиосистемы, состоящей из аналоговых и цифровых блоков.
Выводы
Программа Ptolemy позволяет моделировать достаточно широкий круг приборов, которые могут быть описаны в терминах цифровой или аналоговой схемотехники. Для описания структурно сложных систем Ptolemy позволяет использовать иерархический принцип построения проекта. Моделирование цифровых схем в Ptolemy осуществляется с помощью абстракции синхронного потока данных (SDF) и синхронизированного по времени потока данных (TSDF).
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